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1 September 2016
This file contains notes on the Wilcom EmbroideryStudio e3.0Z Update 6 release. This update is intended for
installation with any released version (already installed) of Wilcom EmbroideryStudio e3.0. It contains all
improvements and fixes contained in other interim updates, including e3.0H through e3.0Z Update 6.
Note: Administrative privileges are required to install the software update. If you are installing to a corporate
network, an administrator password may be required during update installation.
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Release Notes

Improved features in ES e3.0Z Update 6
The ESe3.0Z Update 6 software update corrects a number of problems, already existing or introduced with
previous updates.

Cross stitching
Recalculation of cross stitch connectors
Problems have occurred when transforming some cross stitch objects. In some circumstances, when the user
manually edits start/end points of cross stitch fills in order to minimize connectors, and then transforms the
objects in some way – moving, copying, pasting, mirroring, etc – the original connectors are replaced with
automatically generated long connectors. This problem has been rectified.

Mirrored cross stitch objects
Problems have been reported by some customers when mirroring cross stitch objects. Cross stitches are recalculated to fit a hidden ‘universal cross stitch grid’. This is useful when doing traditional cross stitch designs
where all objects touch. For fashion and textile designs, objects don't usually touch and so do not have to fit
the same grid. With this update, cross stitch objects are no longer re-generated during copy/paste, mirror, or
move operations.

Note: Cross stitch objects will still be re-generated with scaling, rotating or skewing, or reshaping operations.
They will also be re-generated with some mirror-merge operations such as wreath and kaleidoscope.

Inconsistent duplicate cross stitch rows
Problems have been occurring when duplicating rows of cross stitching. Twin rows become single rows and
vice versa. This problem has been rectified.
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Missing stitching in mirrored cross stitch objects
Some customers have reported missing stitching in mirrored cross-stitch objects. This problem has been
rectified.

Connectors
Travel runs in motif fills
Previously, when using certain motif fills, travel runs sometimes appeared above the cover stitching of the
motif.

The following motifs in the single motif set have been reworked so travel runs do not appear above the cover
stitching:



Cross05
Cross13
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Cross14
Kite11
Leaf02
Shapes01
Star14
Star18
Wave04
Zigzag19
Zigzag22
Zigzag24
Zigzag26

Zingers with sharp corners
Previously, ‘zingers’ were created on sharp corners in closed Input C. The zinger is created when applying
‘Smart Corners > Cap Corner’ to a closed K-shaped Input C object. This problem has been rectified.

Satin stitch with Freehand
Digitizing satin stitch with ‘Freehand - Open Object’ has sometimes produced incorrect stitching such as
unusual stitches appear in resulting Input C objects or spikes appearing at sharp corners. This problem has
been rectified.

Nested objects with Mirror-Merge
Problems have been reported when using Mirror-Merge with nested objects. The nested stitch sequence is lost
in the resulting objects. This problem has been rectified.
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Start/end points after outline and offsets
Problems have been reported with relocated start/end points when creating outlines or offsets. With this
update, start/end points are no longer moved when Outlines & Offsets is applied. Generated outlines now start
near the original ending point of the source object.

Artwork & images
Inserting 32 bit images
A number of related problems have been reported involving 32 bit images. 32 bit BMP files now display
correctly. For instance, when capturing design bitmaps in EmbroideryStudio and then reopening in ES, the
image displays as a black or multicolored image.
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A similar problem occurs when:
 Pasting images into the design window captured by the Print Screen function
 Importing 32 bit BMP images into ES via File > Import Graphics.
These problems have been rectified.

TrueView simulation
Previously, when viewing designs in TrueView, the color appeared to shift in the spectrum compared to the
non-TrueView color. This is more noticeable when using pastels. This problem has been rectified.

Zooming vector objects
Customers have reported that zooming a vector object can result in inaccurate dimension measurements.
Instead of a rectangle, say 20mm x 30mm, the object may be slightly enlarged. This problem has been
rectified.

Lettering
Upright script font
The Upright Script font has been repackaged with corrected spacing.
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Lettering text input field
Problems have been reported concerning the previously fixed width of the lettering text input field. The field
now resizes dynamically in accordance with the dialog.

Monogramming dialog
Problems have been reported with Monogramming dialog for languages other than English. Most do not easily
fit within the space available. This problem has been rectified.
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Motifs & sequins
Custom motifs
Requests have been made to allow users to selectively remove color functions or other functions from custom
motifs. Two new options have been added to the Create Motif dialog. Selecting ‘Remove Color Change’ will
remove all color changes without affecting other functions. Selecting ‘Remove Other Functions’ will remove all
functions except color changes.

Motif runs with sequins
Several customers have requested the ability to include sequins inside motifs. Sequins can now be included in
custom motifs. Note however that the sequins will only be visible in motif runs, not fills.

Preview twin sequins with Manual Sequin
When digitizing twin sequins with the Manual Sequin tool, you can switch between left/right sequins using the
<Tab> key. Previously, the preview was a black outline, whatever color the sequin. Now, sequins are colored
for easy preview before pressing <Enter> to commit.

New hot keys for twin sequins
Sequin users have requested a new hot key to manually drop the ‘other’ sequin in twin sequin designs. This
completes a feature added in ESe3.0Y.




The hotkey introduced in e3.0Y allows you to drop a sequin with the <5> key.
Hot key <6> is now available for the other sequin drop.
Hotkey <4> deletes the sequin from current stitch point.
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Miscellaneous
Sharp corners with contour stitching
Problems have been occurring with sharp corners in Input A or C objects when applying Contour stitch.
Stitches sometimes bulge in unpredictable ways beyond the shape. This problem has been rectified.

Barcode file type extension list
Many companies are switching to barcode readers on embroidery machines to ‘pull’ designs from network
locations rather than having the computer ‘push’ them to the machine. The Production Worksheet barcode
capability provides an option to encode machine file type in the design name. This is needed by some
machines. The list now includes all important file types, including Z00 and Z01 for ZSK designs.

Outline / object recognition
Problems have been reported with outline/object recognition when opening DST files. Objects such as the ‘N’
in the sample below are not always recognized correctly. This problem has been rectified.
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Improved RGB color values for Isacord 40 thread chart
Some RGB colors were not being perfectly matched to threads in the Isacord 40 thread chart. Values have
been updated and are much better for all colors in the thread chart.

System improvements
Dongle timeouts
Problems have been reported with dongles timing out earlier than expected under certain conditions.
Depending on the time zone it may not actually happen at midnight and may appear to time out earlier. This
problem has been rectified.

Backup file errors
When opening designs from the backup folder and attempting to save them to a different folder, users were
erroneously told the design was being used by a different process. This problem has been rectified.
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Users have complained of another confusing backup file error which can occur when trying to overwrite the
original EMB file. This too has been rectified.
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Improved features in ES e3.0Z R2
The ESe3.0Z R2 software update corrects a number of problems, already existing or introduced with previous
updates.

Improved mechanism for ES Auto Update
ES Auto Update default behaviour and terminology have been improved for easier use. You now have the
option of installing immediately or postponing till later.

Note that the new mechanism will not take effect until updates following ES e3.0Z R2.

Connection Manager issues
With the previous update, software crashes were reported when using Connection Manager with DFS and
watch folders. This problem has been rectified with the latest update.

Freehand Drawing screen display
After ESe3 Update 5, it was reported that Freehand Drawing was not displaying properly onscreen. This
problem was exacerbated when using Freehand with Repeats activated. This problem has been rectified with
the latest update.
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Support for non-DOS embroidery disks
Support for non-DOS embroidery disks was removed in an earlier version of the software. For users still using
non-DOS floppy disks, limited support has been returned. Supported disks are summarized below:
Format

Density

Barudan 2HD

DS/HD

Barudan FDR

DS/DD

Barudan FMC

DS/DD

Barudan S-FMC

Non-DOS

Read

Write

















DS/HD





DOS

DS/HD





Happy

DS/HD





Tajima

DS/HD





Toyota

DS/HD





ZSK

DS/DD





ZSK TC

DS/HD









Note: As before, however, non-DOS disks will only work on Windows 32 bit operating systems. 64-bit versions
of Windows OS do not support non-DOS disks. Nor do modern PCs.

Removal of missing text characters
Sometimes you may want to try out a few different alphabets before choosing the preferred one. Problems
have been reported with disappearing text characters which are removed from the text input field if the
selected alphabet does not support those characters. With the latest update, the input field text preserves all
characters regardless of whether the selected alphabet supports them. Missing characters are displayed as
boxes.
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Language support
With the latest update, a number of user interface problems affecting non-English languages have been
rectified. Improvements affect:








Dutch
French
German
Greek
Italian
Portuguese
Spanish
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Improved features in ES e3.0Y R4
The e3.0Y_R4 software update correct a number of problems introduced with the ESe3.0Y release.

Show Repeats in Print Preview
Update 5 includes significant improvements to the Show Repeats function. After installing Update 5 however,
the ‘Show Repeats’ option in Print Preview can cause ES to crash. The e3.0Y_R3 update rectifies this
problem.

Show Repeats with TrueView
With the e3.0Y_R4 update, Show Repeats can now be seen in Print
Preview with TrueView on.

Show Repeats with Slow Redraw
After installing Update 5, design repeats did not display correctly when
running Slow Redraw. The e3.0Y_R4 update rectifies this problem.

Changing monogram alphabets
Previously, when changing alphabets in the Monogramming dialog, any
unsupported characters already keyed into the input field were removed.
The e3.0Y_R4 update rectifies this problem by preserving text, even
when previewing an alphabet which may not support all characters.

Nudging with arrow keys
After installing Update 5, nudging design elements with the arrow keys
caused wireframe and stitches to misalign. The e3.0Y_R4 update
rectifies this problem.

Schiffli Disk Convertor
The Schiffli Disk Convertor is now working on 64 bit operating systems –
including Windows 7, Windows 8.1 and Windows 10 – with DOSBox
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installed. This third-party software can be sourced from www.dosbox.com.

Network license security error
With Update 5, some users reported a network dongle security error whereby the application was reported to
have exceeded the number of network licences. The e3.0Y_R4 update rectifies this problem.

Dongle driver update
With the e3.0Y_R4 Update, the dongle driver is updated to V7.41.
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New & improved features in ES e3.0Y
The main scope of the e3.0Y software update has been to provide better support for sequin digitizing,
repeating designs, as well as more general productivity / usability improvements and fixes.

Source: Design kindly provided by IIGM Pty Ltd.
Note: This update includes enhancements that are not supported with Windows XP and Vista operating
systems. If you require XP and Vista operating system support for ESe3.0Y please visit
http://www.wilcom.com/gethelp/support/downloadcenter.aspx. Download the ESe3 Update 5 (ES e3.0Y) for XP
and Vista.

Key features at a glance


Support for Twin Sequin for most Chinese machines



Show Repeats in TrueView, including sequins



Show Repeats of artwork



Automatic Run stitch Backtrack for Sequin Run



Shortcut key and a new icon for Manual Sequin Drop



Eight (8) new sequin fixing stitches, including a new fixing stitch for Laesser



Export of vector files from ES



New Stitch Edit toolbar



Shortcut keys for Paste Special functions



Shortcut keys for Mirror operations



Option to run Small Stitch Filter continuously
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Sequinning
Twin Sequin Support for Chinese machines
ESe2 already provided twin-sequin support for Barudan and Tajima machines. With this update, ES now
supports the Dahao controller used by many Chinese machines. Make sure Dahao is selected as your
machine type.

Set up your twin-sequin palette in the usual way. Sometimes you will want to set up two (2) twin-sequin groups
as shown below depending on your machine configuration. Refer to the Sequin Supplement for further details.

If you have selected Dahao as your machine type, Dahao twin-sequin DST file format is available on output.
The Drop Sequin functions are inserted according to Dahao twin-sequin requirements.
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Note that Dahao machine format files created in the current update are not backwards compatible with
previous versions of ESe3. You must install the current update to read these files.

Show repeats for Sequins in TrueView
Many customers make traditional garments such as sarees which employ continuous and sometimes
overlapping designs. It is important to see these designs together with their repeats. Previously ES could not
show repeating sequin designs in TrueView because technically sequins are not stiches. The Show Repeats
function now displays repeated sequin designs in TrueView.

Automatic backtrack with sequin runs
Digitizers sometimes want to generate a sequin run and then overlay a plain run so that sequins are more
securely fixed. Another reason for backtracking is to avoid the creation of jump stitches between objects. When
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Backtrack or Repeat are applied, the software now generates manual stitches for selected Sequin Run objects
but leaves other functions unaffected.

Shortcut keys for Drop Sequin commands
ES provides many Automatic Sequin functions. However, the manual Drop Sequin function is frequently
required in situations not covered by Sequin Run or when that tool is not available. Typically users will…
 Create stitching using tools such as Run.
 Use Travel keys to traverse the stitch list and drop sequins where desired.
 Rely on run stitch and/or backtrack stitches to hold sequins in place.
This technique is widely used in combination with normal run stitch objects and other situations where
dedicated Sequin Run objects do not suit. To facilitate this technique, Drop Sequin and Clear Function icons
have been added to the Sequin toolbar. The shortcut key ‘5’ has been added for Drop Sequin.

New sequin fixing stitches
New sequin fixing stitches DOWN, UP, NK01, NK02, NK03, WR01, WR02 have been added with the latest
update to improve sequin digitizing and production.
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Down and Up fixing stitch types are designed for use with vertical sequin runs and fills. Other fixing stitch types
are summarized below.

A new sequin fixing stitch from Laesser has been included in the sequin library. It has been implemented as
D01-4. This can be used for any machine but it works well for Schiffli.
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Display of sequin function symbols
The display of sequin function symbols has been improved when TrueView is off and Show Functions is on.
Both appear in their selected colors and can be turned on or off via Show Functions and Show Stitches
toggles.

Sequin outlines on default Schiffli template background
The default Schiffli template has a default background color of black. When the user chooses to create a
design based on the Schiffli template, sequin outlines cannot be seen unless TrueView is activated or the
background changed. With this update, the problem is solved by displaying the sequin in the sequin palette
color.

Traveling through sequin designs
When traveling through a sequin design, undropped sequin outlines now appear in the ‘Unsewn’ color defined
in Background & Display Colors dialog.
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Mirror-merge of manually created sequin objects
Previously, mirror-merge operations which were applied to manually created sequin objects sometimes lost
sequins in the duplicates. While working for Sequin Run objects, it did not for Manual Sequin objects. This
problem has been rectified with the current update.

Sequin fixing stitch colors
Sequin fixing stitch previews have been changed to green for clearer visibility. See above.

Sequin On/Off functions
Some customers have reported that Sequin Codes appear in the Stitch List for freehand drawing designs. The
issue affected machine formats that support sequins such as Barudan DFR-II Lockstitch (default), Tajima,
Tajima TBF, etc. This problem has now been rectified. Creating a freehand open object with either Run, Triple
Run, Motif Run, Backstitch, Stemstitch, or Input C, no longer results in Sequin On/Off functions being added to
the stitch list.
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Productivity / usability
Show Repeats in Trueview
With this update, ES shows what a repeating design looks like on the fabric in TrueView.

Show Repeats of vector artwork
With this update, the Show Repeats function now works for artwork as well as embroidery and sequin objects.
Thus more accurate digitizing can be achieved, especially for continuous designs.

Wilcom EmbroideryStudio e3.0Z Update 6

1/09/2016

23

Release Notes

Stitch Edit toolbar
Some customers make frequent use of the Process Stitches tool in order reduce stitch counts for selected
items by % and other factors. A dedicated Stitch toolbar has been added for this and other stitch-related
commands.

The toolbar contains the following tools:
 Generate Stitches
 Stitch Edit (same as Reshape toolbar)
 Stitch Edit Selection
 Process Stitches
 Split Object
The toolbar can be turned on/off via the Window > Toolbars menu or by right-clicking the toolbar blank area.

Shortcut keys for Paste Special options
Paste Special provides four options. Some digitizers use these a lot and hence need to change quickly
between them. Shortcut keys are now available to make this possible. They are listed in the Edit > Paste
Special submenu.
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Shortcut keys for mirror functions
Fashion and textile designs often use copied and mirrored design elements. For productivity reasons, shortcut
keys are now available for mirror operations.

Shortcuts are:


Mirror Horizontally - Ctrl + 1



Mirror Vertically - Alt + 1

Shortcut keys for color functions
Some customers use Select by Color and View by Color functions a lot when optimizing designs. For
productivity reasons, shortcuts have been added for Select by Color and View by Color.
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Shortcuts are:
Select by Color - Ctrl + Alt + A
View by Color - Alt + C

Small stitch filter
Previously the small stitch filter only ran automatically when outputting to stitch file. With the latest update, the
filter can now be applied continuously, on output only, or never.

When set to ‘Always’, the filter will be automatically applied in the background whenever objects are edited or
digitized. When set to ‘On Output’, ES behaves as before by applying the filter only on printing or stitch file
output.

Mirror Merge wreath points
Some customers making fashion / textile designs, particularly Saree and Indian dress designers, make
extensive use of the Mirror-Merge feature. The limit for allowable wreath points has been increased to 100.
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Quick clone with offsets
It is very handy to be able to right-click and drag an object to ‘quick clone’. It is even handier that ‘quick
duplicate’ (Ctrl+D) remembers the offset and repeats it. If you want to constrain quick clone to the horizontal or
vertical, you hold down <Ctrl> as you drag the duplicate object. Some users have reported shifts in offset
position of at the time of duplication following this type of operation. This has been rectified.

Marquee selection while auto-scrolling
Problems have been reported when zooming in on a large design and using the selection marquee. While
auto-scrolling off screen, the selection marquee stops before reaching the lower extent of the design. This
problem has been rectified with the latest update.
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CorelDRAW screen persistence
Problems have been reported concerning persistence of the CorelDRAW window even after switching to
embroidery mode. This problem has been rectified.

Stitch improvements
Tight curves on Input C
Problems have been reported with the generation of tight curves on Input C objects. Stitches are tending to
break. This problem has been rectified.

Complex Fill overlap value
ESe3 now defaults to ZERO overlaps for internal segments. The user can change to any value.
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Irreconcilable stitch angles in Fusion Fill objects
Previously, when adding irreconcilable stitch angles to Fusion Fill objects, parallel stitching was produced with
no ‘irreconcilable angles’ warning. With this update, irreconcilable angles are identified. Similarly, conflicted
stitch angle lines are now highlighted in Reshape mode.

Max stitch values for Lässer machines
Until now, it has not been possible to adjust stitches longer than 16.5 mm in Schiffli format. However, Lässer
machines are able to create stitches of 25.4 mm. With the latest update, it is now possible to change max stitch
/ jump values to 25.4mm.
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File handling
Export vector files for appliqué cutting lines
Previously, ES allowed the export of vector files via CorelDRAW. With this update, the File > Export As has
been added to ESe3. Thus Advanced Digitizing and Vector Digitizing products can output vector files as was
possible with ES 2006. The user can save vector files to EMF or EPS formats.

Create multiple output files with Team Names
Previously the ‘Create multiple output files’ option did not work when sending Team Name designs via
Connection Manager. This has been rectified with the current update. Sending team name designs using
Barudan U or DST to a machine folder on C: drive is working as expected.

Machine runtimes written in CSV format
Machine runtimes written in CSV format are interpreted differently when opened in Excel. For example:
1. "22:39" (22min, 39sec) in CSV is interpreted as "22:39" in Excel (22hours and 39min)
2. "28:17" (28min 17 sec) is interpreted as "28:17:00" (28hours 17min 0sec)
With the latest update, runtimes appear as expected when opened in Excel in the format ‘Runtime (hr:min:sec)’
– e.g. ‘0:22:39’, ‘0:28:17’, etc.

Happy TAP format – support for needle assignment
The current HAPPY TAP format in ESe3 does not support needle assignment. Support has now been
implemented for the Happy ‘HP1’ format (restricted to 16 colors on 16 needle machines). The benefit is that the
machine operator does not have to manually program machine needle numbers to set the correct color
sequence.

Backup design keep original extension
Previously backup files were given the extension *.BAK irrespective of original file type. Files are now saved to
the backup folder with the native file format and not as BAK.
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Saving JEF files with certain hoops
Problems have been reported when saving JEF files with new Janome hoops. Some designs cannot be saved
as JEF because the machine does not support the selected hoop. Janome hoops in ES e3 have now been
updated to match Janome Digitizer V4.
Also problems have been reported with saving JEF files with 200x200 or 140x200 hoops for any machine
model. The software reports that the target machine is not supported. This problem has been rectified.

Sending ZSK designs via Connection Manager
Problems have been reported when sending designs to ZSK machines via the Connection Manager. When
sending designs in ZSK TC code or DST, they can be seen in the shared network folder but the machine is
unable to read them. The same file saved directly to network folder can be seen by the machine. This problem
has now been rectified.

GemMaster 2.9 / ES e3.0V compatability
Previously you could not export SRT files in GemMaster 2.9 from YNG files created in ESe3.0V. Nor did the
Sort Simulation work for these files in GemMaster 2.9. This problem has been rectified. Also with the latest
update, YNG files saved from ESe3 can be opened in GemMaster (V2.9.9) and run on a CAMS machine.

Languages
Additional languages
The ESe3 user interface is now available in the following languages:


Swedish



Greek

Resources are included in the latest update.

Arabic Letter Sequence dialog
Previously there were problems with overlapping controls in the Arabic Letter Sequence dialog, making it hard
to select checkboxes. This has been rectified.
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Color dialog in Hebrew language environment
Previously, in the Hebrew language environment, the Windows Color dialog did not display correctly. This
happened when regional settings were set to Israel location and Hebrew system locale. This problem has been
rectified with the latest update.

System security
Dongle time-outs
When a dongle is due to time-out in 14 days, ESe3 issues a time-out warning at start-up. This warning no
longer appears while the software is actually running.

Security Device Setup dialog
When starting ESe3 with a timed out dongle, the Security Device Setup dialog is not always displayed to
enable users to enter access codes to re-time the dongle. This has been rectified.

Windows 10 dongle drivers
The latest dongle drivers for Windows 10 are included with the latest update.

Miscellaneous
Option to print design filename
A variation of the ‘None’ info option, users now have the option of including the design filename as the printout
information without any other text. This option is available on the Print Options > Info tab.

Prompt user to load recovery files
ES now prompts the user if there are any recovery files from a previous crash. This is consistent with how
other Windows Applications recover from a crash by saving work files. Thus the user does not lose the time
already spent on digitizing.
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New & improved features in ES e3.0V
The main scope of the e3.0V software update was to provide language support for Arabic and Russian, and to
further improve the TrueType font conversion engine. The ES e3.0V update also sees improvements in the
Lettering Kiosk with the inclusion of customizable monograms.

Language support
Support for Arabic language
Responding to requests from the marketplace, ESe3 now provides Arabic language support.

Russian language support
This release now incorporates a Russian interface for EmbroideryStudio which can be selected during
installation. Russian language support also includes:



ES Design Explorer GUI
ES Quick Start Guide - PDF version

Onscreen version of QSG for languages
The software now includes onscreen versions of the Quick Start Guide in languages other than English.

Lettering Kiosk improvements
Personalizing of monograms
Support has been added to allow personalizing of monogram objects in the Lettering Kiosk. Only text can be
changed in Kiosk mode. Monogram templates can be created and added to the Kiosk.
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Slow Redraw in Kiosk mode
Previously the Slow Redraw dialog remained open in Kiosk when started from ESe3. As a result, some
controls in the Kiosk could not be used. This problem has been rectified.

TrueType font conversion
Composite character conversion
There are characters which can be regarded as ‘composites’. In European fonts, these are relatively rare – e.g.
‘i’ or ‘%’. However, Asian fonts have many characters which contain multiple elements. Some of these are
inadvertently eliminated during conversion. The current TTF conversion, including Korean improvements,
implements advanced processing for composite letters.

Automatically generated stitch angles with turning fill
There is a problem of consistency between automatically generated stitch angle lines. It can be observed
mostly in long sections. Previously, users fixed this problem by adding new stitch angles to the middle of such
sections. The improved automatic feature now provides the same or similar results.
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TrueType font conversion settings
When the user chooses a TTF font in the Object > Lettering dialog, common, one-size-fits-all settings are
applied by default. These are not necessarily the best, particularly for serif fonts such as Times New Roman.
To use calculated settings, the user must click the Suggest Values button in the Conversion Settings dialog.
Suggested values are now default values for every selected TTF font. Default conversion is now much better.
As always, default conversion settings can be further refined by the user.

Improved stitch angles in ring shapes in TTF conversion
Sometimes stitch angles produced near the edge of ring-shapes make the stitched shape look more like a
closed C rather than an O. This problem has been rectified.
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Clarendon BT font conversion
There have been requests to improve turning strokes in the conversion of Clarendon BT font. Particularly E, Æ,
È, É, Ê, Ë, CE. The current TrueType font conversion provides high quality results for the reported letters.

Comic Sans font conversion
ES now correctly generates the ‘umlaut’ when creating the letter ‘a’ with Comic Sans TTF.

Arial TrueType Arabic character conversion
Some Arabic characters in Arial TTF conversion produce poor stitch angles. These have been improved.
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Batang TrueType font conversion
Batang TrueType still has issues with font conversion. Some object conversion ends up outside the object
shape. This has been improved.

Korean font conversion
Korean TrueType font conversion presents a number of problems:
 Some Korean TTF characters are not correctly decomposed into patches according to Korean rules.
 Some letters appear as question marks so it is impossible to create a word.
The improvements made in Korean TTF conversion involve minor improvements to stitch angles and related
improvements. There may, however, remain some inconsistencies with the results produced.

Note: The improvements have general applicability and are available for all types of fonts, not only Korean.
They are also available for all ES features that use the TTF conversion method.
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Other TrueType font conversions
A number of specific fonts have been tested which have been reported to produce poor letter quality.
Conversion quality for the following fonts has been improved:











Haettenschweiler TTF
Gungsuhche TTF
Garamond TTF
Bookman Old Style TTF
Century Gothic TTF
Palatino Linotype TTF
Georgia TTF lowercase
Impact TTF uppercase
Tahoma TTF regular lowercase and bold uppercase
Trebuchet MS TTF uppercase

Stitch quality improvements
Stitch generation for Complex Fill
With comparable objects, needle penetrations generally follow Input A outlines more closely than Complex Fill
outlines. Complex Fill stitch generation has been improved with this release.

Stitch length of tatami underlay for Fusion Fill objects
The stitch length of tatami underlay for Fusion Fill objects does not always follow the stitch length setting in the
Object Properties dialog. The stitch length can become too long and cause machine stitching problems. This
problem has been rectified.

Bling improvements
Exporting bling lettering to Yongnam GemMaster format
Previously bling lettering (rhinestone alphabets) was not being correctly output to Yongnam GemMaster
(*.YNG) format. This problem has been rectified.
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Bling palette color swatch
Previously the Bling Palette color swatch did not highlight the selected bling color. It now behaves the same
way as the Background Color swatch.

Input/output improvements
Multi-decoration file output
Performing a multi-decoration file export sometimes results in an access violation when closing the product if
CorelDRAW is not installed. Also, Generic Write Errors may result on exporting print, applique, and bling via
the Multi-Decoration File Export dialog without CorelDRAW installed. The user is now prompted to install
CorelDRAW if they want to export print, applique, and bling via MDFE.

TAP files for Happy machines
Problems have been reported when loading TAP files into Happy machines. This problem has now been
corrected.

Opening JEF+ file format from MB-4 machine
Previously the user was unable to open JEF+ files saved on the Janome MB-4 machine. The Janome MB-4
Machine is now supported by direct connection via Connection Manager. This limitation has been removed.

Saving sequin fills to e2 format
Previously Sequin Fill was saved incorrectly to e2 EMB file format. Loading the design into ESe2 caused it to
crash. This problem has been rectified.

System improvements
Updated HASP dongle driver
This release installs the latest HASP V6.64 dongle driver.

Sequin fill reshaping operations
The system can hang when reshaping Sequin Fill objects. This problem has been rectified.
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Serial Port Setup dropdown values
Previously Serial Port Setup dropdown values displayed incorrectly after installing the ES e3.0R Update. The
problem with merging defaults has been corrected.

List of formats in Digitizer Setup
Similarly, the List of Formats droplist in Digitizer Setup displays incorrectly after installing the ES e3.0R
Update. The problem has been corrected.

Monogram crashes
Selecting the Lettering tool with a monogram object selected can cause the system to crash. This problem
has been rectified.

Wilcom EmbroideryStudio e3.0Z Update 6

1/09/2016

41

Release Notes

Other improvements
Copy & paste for whole designs
A problem has been reported when trying to copy and paste whole designs or parts of designs to form
repeating elements. This has been corrected.

Sequence toolbar ‘back 1 color’
The Sequence toolbar Back 1 Color function fails to work when selecting a second object in the Color-Object
List. The button is now correctly enabled when selecting the second object.
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Enveloped lettering proportions
Enveloped lettering may lose its correct proportions when lettering text is updated. This problem has been
rectified.

Thread chart sorting
Problems have been reported with the sorting of threads. The Edit Thread dialog picks up the wrong thread
after sorting operations. This problem has been rectified.

Stitch orientation of Input C objects
The stitch orientation of Input C objects can be lost after saving/opening a design or copy/paste operations.
The object is scaled correctly but the stitch direction may be reversed. This problem has been rectified.

Remove Overlaps with appliqué objects
The Remove Overlaps command produces incorrect results when applied to appliqué objects. This problem
has been rectified.

Customer names on production sheets
Previously customer names in the production worksheet were lost when updates were installed. This problem
has been rectified.
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New & improved features in ES e3.0R
The main scope of the e3.0R software update was to provide a new, easy-to-use Kiosk capability for cap and
other embroidery. A number of other issues have been resolved for motif runs, file output and system issues.

Lettering kiosk
The EmbroideryStudio e3.0R Update provides a new, easy-to-use Kiosk capability for cap and other
embroidery. The lettering kiosk is primarily intended for use at retail outlets where fast and simple
personalization of standard design layouts is required in consultation with customers. The Kiosk feature is
packaged as an optional Productivity ‘Element’.

The benefits for retail staff are:
 Minimal training time
 Minimal production errors
 Improved customer satisfaction
 Increased productivity
 Easy configuration for changing requirements
 Support for several brands of machine
 Simplicity of kiosk mode together with full embroidery lettering capabilities for supervisors.
The lettering kiosk provides a set of pre-defined design layouts and the ability to easily personalize them by
modifying text and color. You can create your own layouts as well. Designs can be sent to machine from the
kiosk via a single button press.
Please contact your Wilcom distributor for more information about this optional Element.

Motif run improvements
ES e3.0R includes the following improvements to motif run functionality.
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Motif Run properties after resizing
When resizing a motif run on screen in Reshape mode, changes to object properties are now correctly
reflected in the Object Properties dialog.

Motif Run properties after mirror and reshape operations
In earlier versions, mirroring a motif run and then reshaping the baseline caused motifs to flip around the
baseline.

This problem has been rectified. Motif orientation is maintained.

Selection handles & mirrored pattern previews
When a motif run object is mirrored in ES:
 Selection handles do not appear at the correct position.
 The pattern preview when dragging the object is incorrect – it appears mirrored.
This problem has been rectified.

Motif run color & orientation changes
Changes in motif run color and orientation have been reported in certain designs when digitizing new objects.
This problem has been rectified.

Mirroring motif runs with reshaped patterns
When mirroring motif runs, any manual reshaping to individual patterns may be lost. This problem has been
rectified.
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Motif sizing following reshape operations
Unexpected changes in motif size are known to occur when reshaping certain motif runs. This problem has
been rectified.

Language-related improvements
ES e3.0R includes the following improvements in LOTE support.

Dutch language available
The EmbroideryStudio e3.0R Update now provides a complete translation of the interface into Dutch language.
It is also supported with a Dutch Quick Start Guide.

Design area unit (mm²) in Japanese language
There was a problem with the display of the design area unit, mm², in the Japanese interface. This issue
affected the Information tab of Design Properties dialog, Print Preview and exported design properties CSV
file. The issue has been resolved.

Auto-update dialog
The Auto-Update dialog is now translated in languages other than English.

Miscellaneous improvements
ES e3.0R includes the following system improvements.

Travel by Trim shortcut
There is a conflict with the Ctrl + Left/Right arrow shortcut for the Travel by Trim function. The problem is that
the shortcut is already being used for Travel by Segment. The Travel by Trim shortcut has now changed to
Alt + Left/Right.

Design shifts when saving to PES
Problems have been reported with unexpected shifts when saving certain designs to PES. Lettering, in
particular, is shifted in relation to the rest of the design. This problem has been rectified.

Resizing & reshaping objects with carving stamps
Resizing and reshaping objects with carving stamps has been found to crash the software. This problem has
been rectified.
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New & improved features in ES e3.0Q
The main scope of the e3.0Q software update was to repair a number of system issues. This update also
provides better Korean language support as well as improved EmbroideryStudio e3 Lettering & Editing
functionality. A number of other issues have been resolved for sequins, file output and object property
handling.

System improvements
ES e3.0Q includes the following improvements to system performance.

Writing Defaults file
A number of cases have been reported where EmbroideryStudio has encountered problems writing the
defaults file. A ‘Can't write the Defaults file’ warning message appears and ES becomes disabled. This problem
has been rectified.

Extended use
Problems have been reported when leaving EmbroideryStudio running overnight. Upon trying to open a design
the next day, the application becomes disabled. This problem has been rectified.

Machine Format Settings missing units
Some units of measurement are missing in the Machine Format Settings dialog. This problem has been
rectified.

Lettering improvements
ES e3.0Q includes the following improvements to embroidery lettering functionality.

Teamname Matrix for EmbroideryStudio e3 Lettering & Editing
The 'Teamname Matrix' feature is now available in EmbroideryStudio e3 Lettering and Editing products.
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Auto Letter Spacing for EmbroideryStudio e3 Lettering & Editing
The Auto Letter Spacing feature has been added to EmbroideryStudio e3 Lettering & Editing products. This
feature is important for naming customers.

TrueType Font conversion
TrueType Font conversion has undergone a general improvement in the way fonts are converted to
embroidery patches (decomposition). This applies to all character sets.

Conversion of multi-line paragraph text
Several problems have been reported with the conversion of TTF text. CorelDRAW multi-line paragraph text is
not converting properly to embroidery. Also, problems have been reported when converting paragraph text with
center or right justification. These conversion issues have been resolved.
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Note: Small Paragraph & Artistic Text – in particular, narrow fonts such as script fonts – may not convert to
embroidery. Try increasing font size or try converting directly from the EmbroideryStudio Object Properties >
Lettering tab.

Application of Squared Corner offsets to lettering objects
It has been found that the software can crash when applying ‘Squared Corner’ offsets to lettering objects. This
problem has been rectified.

Digitizing improvements
ES e3.0Q includes the following improvements to embroidery digitizing functionality.

Conversion of vectors to embroidery
There have been reports of software crashes occurring when converting certain vector designs. This problem
has been rectified.

Vector conversion for letter-like objects
Vector conversion for letter-like objects has been improved with the use of Turning Satin. This works better for
narrow turning shapes like letters. Standard conversion still applies to general shapes.
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Curve edge smoothness
Problems have been reported with the relative smoothness of curved edges. The sample shows Input C and
Input A with very high stitch density so the edge line can be clearly seen. This problem has been rectified.

Sequin improvements
ES e3.0Q includes the following improvements to sequins.

Changing Sequin Run Manual fixing type for a single sequin
System crashes have been reported when changing fixing types for single sequins created with Sequin Run
Manual. This problem has been rectified.

Visual feedback when moving sequins with Sequin Edit
Misleading visual feedback when moving sequins using Sequin Edit tool has been fixed with this release.
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Output improvements
ES e3.0Q includes the following output improvements.

Rotate design 180º on output for cap applications
Connection Manager now provides the ability to optionally rotate design 180º on output for cap applications.

A Rotate design by 180° on output checkbox has been added to the Connection Settings dialog. If ticked,
all designs sent to that connection will be automatically rotated.

Color selection for machine icons
Connection Manager also now provides the option to select a color for machine icons. There are 8 colors to
choose from. By default, the ‘next available’ color is pre-allocated as is currently done with the toolbar icon.

Save options added to Connection Manager
An Options button has been added in Connection Manager. This allows users to set up specific file format
options directly from within Connection Manager without having to go to the Save As dialog.
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First needle number written to Barudan format
Previously, the first needle number was not written to Barudan file format. For a single color design, this meant
the machine always defaulted to the first needle rather than selected needle. With this release, all Barudan
machine formats have ‘First CC required’ enabled by default.

Capture Design Bitmap via Email
Problems have been reported when using the Capture Design Bitmap function for sending via email. It fails to
work as expected with Windows Outlook 2010 or Outlook 2007 on Vista. Nor does it work properly with
Windows Live Mail under Windows 7. This problem has been rectified.

Removal of PES Hoop type dialog when saving as PES format
Previously, when saving a design in PES format, the PES Hoop type dialog appeared requiring the user to
choose a size. The dialog has been removed when outputting a PES design via Save, Save As, or
Connection Manager functions. Instead, the PES file format Options button in enabled in the relevant dialog.

Stop function codes with Barudan U?? files
Problems have occurred with the placement of Stop function codes in U?? files. Trim and Stop codes are
placed in the wrong sequence, Stops being placed before Trims. This problem has been rectified.

Needle assignment in Barudan U?? files
The ES e3.0Q update inadvertently introduced a problem with needle assignments in Barudan U?? files, as
well as other Barudan formats such as DSB, T01. Needle bar addressing is offset unexpectedly. With the
e3.0R update, this problem has been resolved.
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However, for e3.0Q designs that already experience this issue, customers need to use the following workaround. In order to stop the shifting, you must set the boring Needle Number in the Machine Format Settings
dialog from 1 to 0 in already-affected design files.

Note: If Barudan machine format settings have been saved as a default in ES e3.0Q, the Boring Needle
number should be set to ‘0’ and updated after installing ES e3.0 R2. If the default boring needle number for a
particular Barudan machine format is not 0, it will continue to cause problems.
To update the default boring needle number
1. Start ES e3.0R.
2. Select File > New to open a blank design.
3. Select Design > Select Machine Format.
4. Select the affected Barudan machine format – e.g. ‘Barudan Z Series’
5. Click Settings.
6. Set the Boring Needle number to ‘0’ and click Save.
7. Click Close.
8. Repeat for any other affected machine formats.

Object properties
ES e3.0Q includes the following improvements in the handling of object properties.

Use of Object Properties with dual monitors
In a situation of dual monitors with the Object Properties dialog in the second screen, the slider bar remains
outside the dialog to the edge the first monitor. In short, sliders are not always visible, being hidden off the
edge of the screen. This problem has been rectified.
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Thread and bobbin lengths displayed in EMB file properties
Incorrect thread and bobbin length values have been reported in the EMB file properties display in Design
Explorer. This problem has been rectified.

Design preview in Windows Explorer
When a design is saved in EMB e2 (or earlier version) in ESe3, the version number is displayed in Windows
Explorer as 3.0. This problem has been rectified.

Thread length values in EMB file in DW/DE
There have also been reports of thread length values in EMB file changing to either 0 or negative values in
Design Workflow and Design Explorer. This problem has been rectified.

Korean language support
ES e3.0Q includes the following improvements in support of Korean language.

Korean language resources added to software
Korean language resources have been added to the latest software installation.

Quality of Korean TTF conversion to embroidery
The quality of conversion of Korean TrueType Fonts to embroidery has been improved, with better detection of
shape cuts and embroidery patches that support Korean unicode characters. Conversion now better follows
Korean stroke rules. Also:


All characters are satin stitch.



Embroidery stitch direction is the reverse of character process direction.

These issues have been addressed with the current release.
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Stitching Korean letters with turning fill style
Korean TTF conversion fails to stitch some letters with a turning fill style – i.e. conversion produces Tatami
Complex Fill objects. This problem has been rectified.
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New & improved features in ES e3.0K
The main scope of the e3.0K software update is to provide runtime estimates for stitching designs on specified
machines.

Runtime analyst feature
The Runtime Analyst calculates the estimated running time for a specific embroidery file on an embroidery
machine using specified RPM values and other runtime parameters. These are used on a design-by-design
basis to determine scheduling, running costs, and calculate payments for production staff. Output can be used
by any third-party software such as ERP and accounting systems.

Typical usage
Information can be made available to various stakeholders for payroll, estimations, and scheduling. For
instance:









The designer creates a new design and saves as EMB and/or stitch file such as U11.
EmbroideryStudio automatically calculates running time.
The designer saves or the system automatically saves calculated results to a CSV file in a designated file
location.
The Payroll Department accesses the CSV file and calculates pay rates for the design. For example:
A Payroll Clerk may need to find out what the runtime will be for a given job in order to pay the machine
operator.
A Manager may need to provide an accurate runtime estimate for any given design so the payroll
department is able to process machine operator payments.
The ERP system accesses the CSV file for estimation and scheduling purposes.
Runtime information may need to be communicated to the Machine Operator who needs to know the
runtime estimate for specific jobs.

Machine setup
Users can set up multiple named machines with specific parameters such as ‘fast speed’, ‘slow speed’, ‘trim
time’, ‘color change time’, etc. Access the Machine Runtime Setup dialog via the Setup menu …
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This dialog is similar to Connection Manager Setup. It lists all machines currently defined in the software for
the purposes of runtime analysis.
Note: Machine types set up here are independent of machines defined in Connection Manager Setup or
Embroidery Machine Connection dialogs.

Machine runtime settings
Click Create to access the Machine Runtime Settings dialog …

Parameters set here are based on metrics gathered both from machine specs, controller and/or empirical
observation.
Parameter

Description

Name

May pertain to a particular machine or a class of machines. The class may be based
on machine model. However different machines of the same model may be set up for
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different purposes – e.g. to run at different speeds. If so, you’ll need to set up
different classes to suit.
Normal (high) speed

Defines the speed at which the machine normally sews. Normally available from
machine specs.

Slow speed

Defines the slowest speed at which the machine runs. Normally available from
machine specs.

Slow above

Defines the length of stitch above which the machine slows down. This value is
automatically adjusted according to speed settings, in particular slow speed. It should
be available from the machine specs.

Trim time

The time the machine takes to perform a trim. May be available from machine specs
or empirical observation.

Color change time

Same as for Trim time.

Stop time

Defines time spend stopping in order to place fabric, foam, etc. This is normally
determined through empirical observation. The number of heads on the machine will
be a determining factor – e.g. 16 heads x 6 secs each.

Design start time

Defines how long the machine takes to go from stop to normal speed – e.g. it may
stitch a number of slow stitches to start off. May be available from machine specs or
empirical observation.

Design end time

Defines stopping time – the machine may slow down and then travel to the center of
the hoop before actually stopping.

All machines or machine classes you define are listed in the Machine Runtime Setup dialog. From here they
can be updated or deleted from the system.

Design information
Once your machines or machine classes have been defined, estimated running time for a specific embroidery
file is displayed in the Design Properties dialog under a new Runtime tab.
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This tab lists available machines and estimated runtimes for the current design. A new Area field on the
Information tab shows total design area. It is calculated by multiplying design width and height, not actual
stitched area. This figure is used to estimate the cost of fabric or 3D foam that can be used in the design.

Outputting design information
Design information, including runtime estimate and relevant parameters, can be output to CSV file for later use
by third-party applications. New data is appended to any existing CSV file.

Predefining export options
Design information can be written whenever the design is:
 recorded into DW database
 saved
A new Options > Export tab allows you to preset these options.
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Manually exporting design properties
The new File > Export Design Properties command allows you to manually save current design properties.

CSV output
The CSV output file includes the following fields. The first group derive from the Design Properties >
Information tab. The next group derives from parameters entered in the Machine Runtime Settings dialog.
Field

Description

Design properties

Data derived from design properties

Date

Date and time of exporting properties.

File name

Name design saved under.

Machine format

Machine format of design.

Stitches

Total number of stitches in design.

Colors

Total number of thread colors in design.

Color changes

Total color changes – may or may not coincide with number of colors.

Stops

Number of machine stops in design.

Trims

Number of trims in design.

Sequins

Number of sequins in design.

Blings

Number of individual rhinestones in design.

Wilcom EmbroideryStudio e3.0Z Update 6

1/09/2016

61

Release Notes
Thread length (m)

Total length of thread used in design.

Height (mm)

Height of sewing area – derived from design extents.

Width (mm)

Width of sewing area – derived from design extents.

Area (mm²)

Area covered by design – calculated according to design extents.

Runtime data

Data derived from machine runtime settings

Below

Number of stitches stitched at slow and high speed according to ‘slow
above’ parameter. Combined numbers should equate to ‘Stitches’ value.

Above
Machine

Machine as shown on Machine Runtime Setup dialog. If there are multiple
machines defined, a separate line entry appears for each.

Normal (high) speed (RPM)

Runtime setting as shown on Machine Runtime Settings dialog.

Slow speed (RPM)

Ditto

Slow above (mm)

Ditto

Trim time (sec)

Ditto

Color change time (sec)

Ditto

Stop time (sec)

Ditto

Design start time (sec)

Ditto

Design end time (sec)

Ditto

Runtime (min:sec)

Calculated runtime of this design according to particular machine as
shown on Design Properties > Runtime tab. If there are multiple machines
defined, a separate line entry appears for each.

Printing of runtime estimates & design area
The Production Worksheet prints the new runtime information. Three new fields to control the new information
appear under the Blocks tab: ‘Area’, ‘Total thread’ and ‘Machine runtime’.

The Machine runtime checkbox is only available if the feature is available in the software. If there are no
machines set up, checking ‘Machine runtime’ has no effect as there is nothing to print.
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Total thread prints the information of the same name in the Design Properties dialog. This information is
included in both Production Worksheet and Production Summary.

Interface & usability improvements
ES e3.0K includes the following interface & usability improvements.

Ruler display
Inch rulers are now displayed in 1/16, 1/8, ¼, ½, and 1" divisions not 1/10s. The grid size can be set in decimal
inches now. This is usable as is.

Transformation & measure tooltips
Unit of measure displayed in the Resize tooltip can now be chosen by the user. Similarly distance moved – e.g.
moving letters – is now displayed in appropriate units. Similarly, ‘Length’ and ‘Angle’ labels have been added to
the Measure tooltip, together with the appropriate length unit.
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Travel tool keyboard shortcuts

All Travel tools now have keyboard shortcuts. New shortcuts include:




Travel by 1000 stitches: Shift + Num- / Shift + Num+
Travel by Function: Ctrl + Page Up / Ctrl + Page Down
Travel by Trim: Ctrl + Left Arrow / Ctrl + Right Arrow

Ctrl+M shortcut for Auto Trace
The Ctrl+M shortcut is not correctly activating Auto Trace. This problem has been rectified.

Appearance tab in Carving Stamp docker
The software crashes on closing all open windows when the Appearance tab is selected in Carving Stamp
docker. This problem has been rectified.

Other Objects option in Save to Template dialog
The Other Objects option is missing in the Save to Template dialog in languages other than English. This
problem has been rectified.

Machine Manager in Japanese
Machine Manager is not working in e3 Japanese. This problem has been rectified.
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Schiffli toolbar Borer Depth display
The Schiffli toolbar does not show correct Borer Depth when traveling through stitches in ES e3. This
problem has been rectified.

Garbage characters in Japanese menus
Garbage characters are appearing in menus in e3 Japanese when using WinXP. This problem has been
rectified.

Photo Flash and Auto Digitize Bitmaps
If the Auto Digitize Bitmaps Element is disabled, the Auto-Digitizing Tools flyout is not available on the
Toolbox toolbar. This means the Photo Flash icon is not available even when the Element is enabled. The
Photo Flash tool is now correctly displayed when enabled.

Thread & fabric improvements
ES e3.0K includes the following thread and fabric improvements.

Access to Manage Thread Charts dialog
The Manage Thread Charts dialog is now directly accessed via the Setup menu along with other asset
management functions. Previously it could only be accessed indirectly via the Thread Charts dialog.
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Madeira color palettes
Madeira color palettes have been updated and now include all the latest threads. The new PolyNeon palette is
also included.

Pull compensation fabric settings
There is a rounding issue with pull compensation settings: values that should be .40 appear as .39. Also the
pull compensation unit is missing in all tabs, except Stablizer, in the Auto Fabric Settings dialog. These
issues have now been resolved.
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New from Template dialog
Previously the last chosen template was not remembered in the New from Template dialog. The Normal
template always appeared by default. This problem has been rectified.

Lettering improvements
ES e3.0K includes the following lettering improvements.

Offset outlines with Kanji lettering
DS now provides the ability to apply offset outlines to Kanji characters as part of a lettering object.

Preview of fonts in lettering properties
Previewing fonts in lettering properties can cause ES to unexpectedly shut down. This generally happens if
there are a very large number of TrueType fonts installed in Windows. This problem has been rectified.
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Available stitch types for lettering and branched objects
There are inconsistencies between stitch types available for lettering and branched objects on the toolbars and
those displayed in the Object Properties dialog. This problem has been rectified.

Stitching & color improvements
ES e3.0K includes the following stitching and color improvements.

Sequin fixing stitch previews
Sequin fixing stitch previews were incorrect for A01-4, A02-8, A03-4, and A04-6. These have now been fixed.
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Slant angle of zigzag underlay
The slant angle of zigzag underlay defaults to 30º when opening an V2006 or earlier EMB files in e3. This can
cause the underlay to extend outside the boundary. With e1.5 and e2.0, the slant angle correctly defaults to
90º. This issue has now been resolved for V2006 and earlier.

Color assignment with Fill Holes
After applying Fill Holes to an object with holes, changing color of the source object incorrectly changes the
color of the fill object. Also vice versa. This problem has been rectified.

File handling improvements
ES e3.0K includes the following file handling improvements.

Using ZSK TC format in Export Multi-Decoration Files
Clicking Options when using ZSK TC format in the Export Multi-Decoration Files dialog crashes the
software. This problem has been rectified.

Design Explorer and DesignWorkflow file display
Previously DE and DW did not display Barudan U?? files. This problem has been rectified.

Saving single sequins
When saving a single sequin created by Sequin Run Manual or Sequin Run Auto to any file format results in
the sequin being lost upon reopening the design. This problem has been rectified.
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Missing formats in ES
TrueSizer can open and save some formats that are not available in ES. This has now been corrected so that
all products open and save the same formats. Also, three additional formats have been added to both
TrueSizer and ES:




Elna (*.EMD)
Janome/Elna/Kenmore (*.JEF+)
Pfaff (*.PCM)
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New & improved features in ES e3.0H
The main theme of the e3.0H software update was to enhance support for third-party machine connection.
Specifically, Happy, ZSK and Brother machines. Other aims of this release include:




Resolve issues associated with multi-language release.
Improve machine connectivity by providing the ability to add named machines and define a network
location for design retrieval.
Fix other outstanding software issues unresolved at the time of last release.

Updated Connection Manager
EmbroideryStudio Connection Manager has been updated to provide a more flexible method of connection to
different machines that appear as removable media or use a third-party application to connect to the machine
and require files to be placed in a specific network location. Each machine, once set up, will only require a
single click in order to send a design to the predefined folder on a network or PC.

Basic workflow
The basic workflow is as follows:
1. Set up a machine connection.
 Each machine has a unique name and ‘Quick Access’ button.
 Each machine can have a unique folder to which designs can be sent so they can be accessed from
the machine control panel or third-party machine connection software.
2. Create a design.
3. Click the Quick Access button for the specific machine.
4. The design is sent to the specified folder.
5. Using the machine controller or third-party connection software, access the design from the network or PC
folder.
6. Load or send the design.
7. Stitch the design on the machine.

Sending a design for the first time
1. Click the Connection Manager icon on the Standard toolbar.

2. Alternatively, select Setup > Connection Manager Setup.
If no connections currently exist, the message appears:

3. Click Yes to start setting up your connections.
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4. The Connection Settings dialog opens.

5. Select the connection type. Choose from:
 Machine folder – e.g. Barudan DFS, HappyLink/LAN, Brother PR series and so on
 Janome MB-4
 CAMS (rhinestone placement machine)
6. Enter a unique machine name. This name identifies the quick access button.
7. Select the file type required by the machine.
8. Enter or browse to a file location on the network or the PC

9. Click OK when complete.
The new machine will appear as a Quick Access button on the Standard toolbar
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10. Click Send to send the currently open design to the specified machine folder.
A confirmation message is displayed.

Setting up additional connections
1. Click the Connection Manager icon on the Standard toolbar.

Alternatively, select Setup > Connection Manager Setup. If a connection already exists, the Send to
Connection Manager dialog opens.

2. Select Setup Connections.
The Connection Manager Setup dialog opens.

3. Click Create.
The Connection Settings dialog opens.
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4. Repeat steps outlined above to set up another machine connection.
As more machines are created, more quick access buttons are added with unique colors for each.

A single click on a machine quick access button will send the current design to the predefined location for
the selected machine.

Other improvements
The e3.0H also includes the following fixes and improvements.

Multi-language issues
Problem

Resolution

Multi-language GUI
problems

A number of problems were reported with regards to truncations and faulty
message strings in languages other than English. These have been resolved.

‘My Product’ for multilanguages

Previously, clicking an element on left hand pane of the ‘My Product’ dialog, when
switched to languages other than English, did not load the corresponding page.
This problem has been rectified.

‘Capture Design
Bitmap’ in French

If running ES in French language, the ‘Capture Design Bitmap’ dialog crashed the
system. This problem has been rectified.

German translation of
Application Fabric
dialog

The Application Fabric dialog title has now been correctly translated as
‘Applikations-Stoff’.

‘New from Template’
fabric selection

Some fabrics could not be selected in the ‘New from Template’ dialog when
switched to languages other than English. This problem has been rectified.

Fabric selection in
non-English languages

Fabrics displayed to the user in non-English language did not match the translated
fabric selected. This problem has been rectified.

Lettering issues
Problem

Resolution

Complex Fill TTF
conversions

When converting letters with holes, such as the registered trademark character ®,
strokes inside the outer ring were not always properly generated. This problem has
been rectified.
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Unwanted Wingdings
in text field

Characters entered into the text field sometimes appeared as Wingding symbols,
even when a Wilcom alphabet was selected. This happened after digitizing lettering
with Webding and Wingding alphabets. This problem has been rectified.

Layout names

Teamname layout names did not always appear in the Teamname Layouts dialog.
Sometimes the name fields appeared blank. This problem has been rectified.

Team Names options
when sending via
Connection Manager

Problems were reported when selecting Team Names options when sending
designs via Connection Manager. This problem has been rectified.

Auto-digitizing issues
Problem

Resolution

Converting embroidery
to graphics

Previously, ‘Convert Embroidery to Graphics’ did not always convert selected
embroidery to vectors. When it did convert, a ‘ghost image’ of the embroidery could
still be seen after conversion to graphics. These issues have been resolved.

Appliqué covering
stitches when
converting vectors

When creating an appliqué object from a combined vector object, covering stitches
for the hole were positioned on the wrong side for appliqué and had to be manually
fixed by swapping ‘Inside’ and ‘Outside’ values. This problem has been rectified.

Thread-related issues
Problem

Resolution

Assigning threads to
colorways

The Color Palette Editor dialog was slow to respond during thread assignments
involving a large number of colorways – e.g. > 50. This problem has been rectified.

Only used colors
displayed in colorways

Colorways available from the Color Palette popup menu showed all colors in the
palette, whether used or not. Now only colors used in the design (underlined in
blue) are displayed. If no color is currently being used, no colors appear in the
combo – only the name and background.

Improved colorway
popup display

The number of colors visible in the colorways popup menu has been increased as
follows:


Maximum number of (used) colors shown has been increased from 8 to 16.



The number of colorways shown at any one time has increased from 4 to 6. The
list can be scrolled to reveal more colorways if available.

System-related issues
Problem

Resolution

Access denied when
starting software

Previously, the very first time ES was started, an ‘Error - Access Denied’ message
was displayed. This problem has been rectified.

Software crashes with
Flatten tool

Software crashes were reported when using the Flatten shaping tool with
embroidery objects. This problem has been rectified.
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Miscellaneous
Problem

Resolution

Rotating objects with
slanted satin

When a Satin or Raised Satin outline object with Calligraphy applied is rotated and
entry and exit points are changed, the stitch angle of the object does not reflect the
original orientation of the object. This problem has been rectified.

Compound Chenille
needle height

The Needle Height controls in the Compound Chenille Effect dialog were not
working properly. This problem has been rectified.

Background preview in
‘New from Template’

When selecting a fabric in the New from Template dialog, the background preview
panel continues to display some background color behind the fabric. This problem
has been rectified.

Object scaling width
and height values

When resizing an object via selection handles, the Width and Height values
appearing in the resize tooltip were out of sync with those of the Property Bar. This
problem has been rectified.

Happy machine hoop
display

Happy machine hoops appear in the software to be smaller than actual size. This
problem has been rectified.

Solving problems
If you encounter a problem with the EmbroideryStudio e3.0K software update, refer to the following sources for
help:
 Wilcom EmbroideryStudio e3.0 User Manual – select Help > User Manual.
 Wilcom EmbroideryStudio e3.0 Onscreen Help – select Help > Onscreen Help
 Windows help – select Start > Help and Support
 Windows manual – documentation supplied with your hardware.
If you are unable to solve a problem, you should contact your Wilcom dealer. Before seeking help, check that
your PC meets the system requirements, and check the Troubleshooting chapter of the User Manual.

Copyright
Copyright © 1990-2016 Wilcom Pty Ltd, Wilcom International Pty Ltd. All rights reserved.
No parts of this publication or the accompanying software may be copied or distributed, transmitted,
transcribed, stored in a retrieval system or translated into any human or computer language, in any form or by
any means, electronic, mechanical, magnetic, manual, or otherwise, or disclosed to any third party without the
express written permission of:
Wilcom Pty Ltd. (A.B.N. 62 062 621 943)
Level 3, 1-9 Glebe Point Rd, Glebe
Sydney, New South Wales, 2037, Australia
PO Box 1094 Broadway NSW 2007
Phone: +61 2 9578 5100
Fax: +61 2 9578 5108
Web: http://www.wilcom.com
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TrueView™ and Point & Stitch™ are trademarks of Wilcom Pty Ltd. Portions of the imaging technology of this
Product are copyrighted by AccuSoft Corporation. The EPS File Import/Export Converter used in this Product
is copyrighted by Access Softek, Inc. All rights reserved.

Contact
If you have any questions, please contact your local Wilcom dealer or distributor in your country.
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